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Part One

10 Things to Help You 
Do the Things You  

Want to Do, Right Now!

Lightroom



PA R T  O N E  ■  L I G H T R O O M

Go under the Lightroom (PC: Edit) menu and choose Identity Plate Setup to bring up 
the Identity Plate Editor (shown above). To replace the Lightroom logo with your own 
logo, choose Personalized from the Identity Plate pop-up menu at the top left of the  
dialog. Now, in the main section below, click on the Use a Graphical Identity Plate radio 
button, and then click on the Locate File button below the preview. Navigate your way 
to your logo, click Choose, and that’s it—it replaces the Lightroom logo with your 
logo. If you don’t have a logo graphic, you can change the Lightroom logo to your 
studio’s name: just leave the Use a Styled Text Identity Plate radio button selected and  
type in whatever you’d like (the name of your studio, company, etc.). While your type is 
still highlighted, use the pop-up menus right below the text field to choose your font, 
font style (bold, italic, etc.), point size, and font color (click the little color swatch).

Replace the Lightroom Logo with  
My Own Logo?

4



PA R T  O N E  ■  L I G H T R O O M

To hide all the other panels, except for the panel you’re working in right now, just  
Right-click on any panel header and choose Solo Mode from the pop-up menu. Now 
when you click on a panel, all the others collapse. Much faster and easier getting 
around (I absolutely love Solo mode!).

 
Stop Scrolling Through Panels So Much?
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PA R T  O N E  ■  L I G H T R O O M

Just Right-click directly on any of the little arrows at the center edges of Lightroom and 
a pop-up menu will appear. That “panel popping” is called “Auto Hide & Show” and to 
stop it from poppin’, just choose Manual from this pop-up menu (you have to do this for 
each individual panel you want to stop poppin’). Now, to open or close a panel, you’ll 
click once on that same arrow at the edge of the panel you want to open/close. Not 
Right-click; just click once to open/close. How to turn off this “Auto Hide & Show” is one 
of the most frequently asked questions I get.

Stop the Side Panels from  
Popping In/Out?
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PA R T  O N E  ■  L I G H T R O O M

If your photo looks kind of flat (especially compared to the image you saw on the back 
of your camera when you took it), one of the best quick fixes is simply to increase the 
contrast amount by dragging the Contrast slider (found in the Develop module’s Basic  
panel) to the right. This does a number of things, besides just making the darkest  
areas of your image darker and the brightest areas brighter (which is pretty much what 
adding contrast does), because it makes the colors in your image appear much richer 
and more vibrant, and our eyes perceive a more contrasty image as a sharper image, as 
well. Personally, I just use the Contrast slider, but if you feel you need more control, or 
more “juice,” than just this one slider will provide, you can go to the Tone Curve panel 
and either use one of the Point Curve presets from the pop-up menu, or you can make 
the shape of any of those “S-curve” presets that have more contrast by clicking- and-
dragging the points until the “S-shape” is steeper (the steeper the S-shape, the more 
contrast it creates). This Tone Curve contrast is stacked on top of anything you’ve already 
done with the Contrast slider, so you can go contrast crazy (once again, I rarely have to 
use this Tone Curve method because the Contrast slider by itself is actually very good. 
But, if you get in a contrast situation, at least you know another place you can go to  
get more).

 
Fix Flat-Looking Photos?
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PA R T  O N E  ■  L I G H T R O O M

Go to the Develop module’s HSL panel (in the right side Panels area; click directly on  
the letters “HSL,” which stand for Hue, Saturation, and Luminance), and then click on 
the Saturation tab up top. At the top left of the panel, you’ll see a little tool—its icon 
looks like a tiny target—and when you move your cursor over it, two little arrows ap-
pear above and below it. That’s the TAT (Targeted Adjustment Tool). Click on it to activate 
it, then move it out over the area in your image that has an individual color you want to 
boost (or desaturate, for that matter)—like a blue sky or green grass or someone with a 
yellow shirt—and just click-and-drag it upward to increase the amount of that color (and 
any associated colors. For example, the sky might be made up of not just blues, but 
aquas, as well. It knows and will move both sliders for you automatically as you drag). 
Click-and-drag downward to reduce the vibrance of that color. To change the brightness 
of the colors, click on the Luminance tab, then click-and-drag the TAT downward, and 
the color gets deeper and richer. If you want to actually change the color (for example, 
you want that yellow shirt to be green), first click on the Hue tab up top, and then click-
and-drag the TAT up/down until the color changes to what you’re looking for. Note: This 
doesn’t just change that one color in that one area—it changes all the similar colors in 
the image. So, if you have a blue sky, and your subject is wearing a blue shirt, know that 
both will change when you make an adjustment to one blue area.

 
Increase Just One Color, Like Blue?
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PA R T  O N E  ■  L I G H T R O O M

It’s an easy-to-remember shortcut: to hide the Edit Pins on your image in the Develop 
module, just press the letter H on your keyboard. To bring them back, just press H again. 
If you just want them hidden temporarily, press-and-hold H and they’ll stay hidden as 
long as you hold that key down. When you release the key, you can see the pins again.

 
Hide the Edit Pins from View?
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PA R T  O N E  ■  L I G H T R O O M

In the Develop module, when you're using the Spot Removal tool (Q) to remove  
distracting things near the edge of objects using the default Heal setting (which is where 
you want to keep it most of the time), it tends to smear (see above), and that’s your cue 
to switch to the Clone tool (see the inset at left). This just changes the method of removal  
and it usually fixes the smearing problem. Also, you might need to drag the Feather 
slider for the tool to the left and right and see which setting looks best for the current 
area you’re working on—just a simple drag to the left and back to the right, and you’ll 
find the sweet spot where it looks best.

 
Know When to Clone Instead of Heal?
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PA R T  O N E  ■  L I G H T R O O M

When painting with the Adjustment Brush, you can either press the letter O or you 
can turn on the Show Selected Mask Overlay checkbox in the toolbar below the center  
Preview area. Turning this feature on can be really handy to be able to see the exact area 
you’re affecting, and specifically to see if you missed any areas (that’s what I did here, 
where I saw that I missed an area and was able to quickly paint right over it with the red 
mask tint turned on).

Keep the Mask Overlay on While  
I’m Painting?
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PA R T  O N E  ■  L I G H T R O O M

In the Develop module, click on the Radial Filter up in the toolbar (right under the His-
togram panel, in the right side Panels area) and then double-click on the word “Effect” 
in the options panel below it to reset all the sliders to zero. Drag the Exposure slider 
quite a bit to the left to darken the overall exposure, then at the bottom of the panel, 
make sure the Invert Mask checkbox is turned off. Now, click in the center of the area 
where you want your dramatic spotlight to fall and drag outward. Stop dragging at the 
size you want your spotlight to be. You can increase the Feather amount to make the 
edges softer, and you can make the shape more of an oval, if you like, by clicking on a 
point at the top, bottom, or sides and just pulling out (or pushing inward). If it’s not ex-
actly where you want it, you can click inside the oval and drag it wherever you like on 
your image. To rotate the oval, move your cursor just outside the oval and your cursor 
will change into a two-headed arrow, then just click-and-drag in the direction you want 
your oval to rotate.

 
Create a Spotlight Effect?
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PA R T  O N E  ■  L I G H T R O O M

To save your Export settings as a preset (so you don’t have to type everything in from 
scratch every time you want to save an image), in the Export dialog, put all your set-
tings in place first, then click the Add button at the bottom of the presets on the left. This 
brings up a small dialog (shown in the inset above) where you can name your preset and 
choose where to save it (by default, it saves under User Presets. And, you can save more 
than one—as you can see here, I have three presets saved under my User Presets). Now, 
next time you want to export, you can use this preset and save a ton of time. Better yet, 
now when you want to export an image, you can just Right-click on its thumbnail and, 
from the pop-up menu, under Export, you’ll see all the export presets you can choose. 
That way, you can skip seeing the Export dialog altogether.

 
Make Saving Less Tedious?
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Part Two

10 Things to Help You 
Do the Things You  

Want to Do, Right Now!

Photoshop



PA R T  T W O  ■  P H O T O S H O P

 
Move Around When I’m Zoomed In?

Press-and-hold the Spacebar and you temporarily switch to the Hand tool. Now you 
can just click-and-drag right where you want. This is so much faster than using the 
scrollbars, which work fine when you’re zoomed out, but stink when you’re zoomed in 
tight—they’re a nightmare (well, that might be a bit of an exaggeration, but only a bit). 
When you’re done moving, release the Spacebar and you return to your last-used tool. 
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PA R T  T W O  ■  P H O T O S H O P

Get My Image to Fit  
Fully on the Screen?

My favorite way is to just double-click on the Hand tool in the Toolbox, but you can also 
press Command-0 (zero; PC: Ctrl-0), if you prefer to use a keyboard shortcut. Also, if you 
switch to the Hand tool (the shortcut is the letter H), you’ll see three buttons up in the 
Options Bar for zooming the overall image: (1) 100%, (2) Fit Screen, and (3) Fill Screen. 
You could go under the View menu, as well, and choose the size you want manually, 
but…don’t waste time digging around in menus, just use one of the first two methods. 

17



PA R T  T W O  ■  P H O T O S H O P

See Just the Tools I Actually Use?

Although you see a whole bunch of tools in Photoshop’s Toolbox, along the left side of 
the window, you probably only use a few of them. Luckily, you can hide all those that 
you don’t use and have a smaller, less-cluttered Toolbox. Here’s how: Go under the Edit 
menu and choose Toolbar (near the very bottom of the menu) to bring up the Custom-
ize Toolbar dialog (seen above). You’ll see two columns: the left side lists all the tools in 
Photo shop, and when you see a tool you’re not going to use, drag-and-drop it over to the 
column on the right, and it’s hidden. When you’re finished, click Done, and now you’ve 
got a smaller, cleaner Toolbox with just the tools you actually use. 

TIP: USE SINGLE-KEY TOOL SHORTCUTS
You can select most tools in Photoshop’s Toolbox using a single key on your key-
board, and some of them actually make sense. For example, press B to get the Brush 
tool, or C to get the Crop tool, or T for the Horizontal Type tool, or P for the Pen tool.  
But then, of course, there’s J to get the Healing Brush tool, or O to get the Burn tool,  
so don’t get used to it making sense. Anyway, to find out any tool’s one-key shortcut, 
just click-and-hold on it in the Toolbox, and when its flyout menu pops out, it will list 
the shortcut. If there are multiple tools that use the same shortcut (like T for all four  
Type tools), then just add the Shift key (so, it’s Shift-T) to toggle through the different 
tools associated with it. 
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PA R T  T W O  ■  P H O T O S H O P

This is going to seem amazingly obvious, but you make gradients using the Gradient 
tool (G). Click-and-drag it to create a gradient between where you started dragging and 
where you stop. By default, it builds a gradient going from your current Foreground 
color to your Background color. So, to change the color, just change your Foreground 
and Background colors. But, there are a bunch of other gradients to choose from. In the 
Options Bar, click on the down-facing arrow to the right of the gradient thumbnail to 
open the Gradient Picker, and you’ll see all the different default gradients you can choose 
from. Just click on the one you want. Of course, there are other sets of gradients you can 
load (just like there are other sets of brushes you can load). Click on the gear icon in the 
top right of the Gradient Picker and, in the bottom half of the pop-up menu that appears, 
you'll see all the different gradient sets you can add. When you choose a set to load, a 
dialog pops up asking if you want to replace (delete) the current gradients and use these 
instead, or just add (Append) these custom gradients to the end of the current set. You 
can return to the default set anytime, by choosing Reset Gradients from the same pop-
up menu and it returns you to the default set of gradients. 

 
Make a Gradient?

TIP: CHOOSE FROM FIVE DIFFERENT STYLES OF GRADIENTS
There’s a linear gradient (a straight line between colors), a radial (circular) gradient, an 
angular gradient, a reflected gradient, and a diamond-shaped gradient. To choose one, 
click on its icon to the right of the gradient thumbnail in the Options Bar.
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PA R T  T W O  ■  P H O T O S H O P

Select the Background  
Behind My Subject?

Get the Magic Wand tool from the Toolbox (its icon looks like a wand…with magic; or 
press Shift-W until you have it) and click it once in the area you want to select. If it’s a 
solid, contiguous area of color, like a nice blue sky or a solid-colored wall, it’ll probably 
select the entire thing with one click, and now you can edit just that area. If it selected 
part of it, but not all of it, press-and-hold the Shift key (this lets you add to what you 
currently have selected) and click on the part that didn’t get selected (for example, if 
your blue sky had clouds, it may not have selected them, so press-and-hold the Shift 
key and click on each area of clouds to add them to your selection). Now, if it selected  
too much (it spilled over into areas you didn’t want to be selected), there are three 
things you can do: (1) Deselect the area you selected by pressing Command-D (PC: 
Ctrl-D) and start over by clicking on a different part of what you wanted to select (for 
example, if you clicked on the right side of the sky and it selected too much, deselect 
and maybe start by clicking on the left side of the sky and see how that looks. It works 
more times than you’d think). (2) Deselect, then go up to the Options Bar and lower the 
Tolerance amount from its default setting of 30. This determines the range of colors it 
will include, so typing in a lower number (like 20 or 10 or 5) means it won’t expand out 
so far and will include fewer colors. Or, (3) switch to the Lasso tool (L), press-and-hold 
the Option (PC: Alt) key and draw over the areas that the Magic Wand tool selected that 
you didn’t want selected. This removes those areas from the selection. 
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PA R T  T W O  ■  P H O T O S H O P

Go under the Image menu and choose Canvas Size (the keyboard shortcut is Com-
mand-Option-C [PC: Ctrl-Alt-C]). This brings up the Canvas Size dialog where you can 
type in the size of the canvas area you want to add. By default, it shows you the current 
size, and then lets you type in a new size. For example, if your current image size is 6.2 
inches wide by 10.4 inches tall, and you wanted to add 1.5 inches of space all the way 
around the outside of your image, you’d need to do some simple math and type in 7.7 
inches for the width and 11.9 inches for the height. To make this easier, just turn on the 
Relative checkbox. To then add 1.5 inches of space all the way around, you just type in 1.5 
in the Height and 1.5 in the Width fields. No math. Boom. Done. Below that checkbox in 
the dialog, that little Anchor grid of nine squares is for when you want to choose where 
to add space. The square with the dot represents your image and, by default, space is 
added equally around your image (that’s why it’s in the middle). For example, if you just 
wanted to add space to the bottom of your image, you’d click on the top-center box of 
the grid (so now anything you add would appear below your image), and you’d type the 
amount you wanted to add (we’ll say 2 inches) in the Height field only. One more thing: 
if you want to add space visually, rather than using any math, do this: Click-and-drag 
out the bottom corner of your image window (to see the area around your image), then 
press C to get the Crop tool, and click-and-drag the cropping border right outside your 
image to add however much canvas area you want. Press the Return (PC: Enter) key and 
it adds that extra space (in whatever color your Background color is set to).

 
Add White Space Around My Image?
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PA R T  T W O  ■  P H O T O S H O P

If you need to expand the edge areas of your image (maybe to make it fit a particular 
size, like a full-bleed to the edges on an 81/2x11" paper size), you can use some Photo-
shop magic that will stretch out unimportant parts of your image (or even shrink them 
in), usually without stretching the important parts. Here’s how it works: Click on the  
layer you want to stretch, then go under the Edit menu and choose Content-Aware 
Scale. Now, literally, just grab a side or corner point and start dragging in the direction 
you want (as seen above), and it somehow figures out what’s important in the image 
and it tries to lock that part down—so, if you’re adjusting a landscape photo, it would 
just stretch the sky without pulling the mountains upward. It does a really amazing job, 
and it’s incredible how much you can often stretch without messing up your image. 
When you’re done, just hit Return (PC: Enter) to lock in your very smart stretching, thanks 
to Content-Aware Scale. One more thing: If there are people in your photo, once you 
choose Content-Aware Scale, but before you actually stretch the image, click on the  
Protect Skin Tones (the little person) icon up in the Options Bar. That helps it to know 
to look for people and not stretch them. 

 
Safely Stretch My Image to Fit?
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PA R T  T W O  ■  P H O T O S H O P

Of course, it depends on what you want to hide, but there are a couple of ways. One is to 
the use the Clone Stamp tool (S) to clone a copy of something nearby right over the thing 
you want covered up. You Option-click (PC: Alt-click) in a clean, nearby area to sample 
that area, then start painting over what you want to remove, and it paints the sampled 
area over it. Another way is to select a piece of the image and use it to cover that area. 
For example, if you wanted to cover a sconce on a wall, you can put a lasso or rectangu-
lar selection around a nearby piece of wall a little larger than the sconce (as seen above;  
I always say “nearby,” so you choose a place that has similar lighting and texture). Then, 
go under the Select menu, under Modify, and choose Feather. Enter 10 pixels to soften 
the edges of your selected area (so it blends in better), and then press Command-J (PC: 
Ctrl-J) to put a copy of that selected area up on its own layer above your current layer. 
Now, get the Move tool (V) and align that copy over the sconce on the wall, so you’re cov-
ering it with more wall (as seen in the inset above). The feathering should help it blend, 
but if you still see an obvious edge on this copy then try this: click on the Add Layer Mask 
icon at the bottom of the Layers panel, get the Brush tool (B) and choose a soft-edged 
brush from the Brush Picker up in the Options Bar, then paint in black over the edge until 
it’s gone and it blends in with the rest of your image. 

 
Cover Up Stuff I Don’t Want Seen?

23



PA R T  T W O  ■  P H O T O S H O P

 
Select Hair?

Get the Quick Selection tool (W) from the Toolbox and paint over the person’s hair,  
but stop short of painting over the edges of it. So, at this point, just make a very basic  
selection, avoiding the outside edge areas (that’s the tricky part). Avoid selecting any  
of the background area, as well. Once your selection is in place, go up to the Options Bar 
and click on the Refine Edge button. When the dialog appears, from the View Mode pop-
up menu, choose Overlay. This view puts a red mask over the areas that aren’t selected, 
and I think this is the easiest way to work with hair, because you can see what you’re  
doing as you do it. Next, turn on the Smart Radius checkbox, and then drag the Radius 
slider to the right to around 2.0 px. Now comes the fun part: move your cursor outside 
the dialog, onto your image, and it changes into a selection brush. Paint over the edge  
areas of the hair, and it automatically senses where the areas are and makes a selection  
of those tough-to-select areas. In most cases, it does an amazing job, especially if the 
person is on a simple background (light gray backgrounds seem to work best, but as long 
as it’s a simple background, it will probably be okay). As you paint along the edges of  
the hair, you’ll see those areas are no longer red and they become the natural color of  
the image. That lets you know those areas are now added to your selection. If it selects  
too much, press-and-hold the Option (PC: Alt) key and paint to deselect those areas.  
At the bottom of the dialog is the Output To pop-up menu. From this menu, I generally 
choose New Layer, so when I click OK, the selected area is placed on its own separate 
layer, and I can then easily put a different background behind my subject. 
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PA R T  T W O  ■  P H O T O S H O P

 
Remove Tourists from a Scene?

Okay, this is part camera technique and part Photoshop magic, but it’s some pretty cool 
magic I have to admit. It starts with you, ideally, shooting on a tripod, so your camera 
is perfectly still while you do the camera technique. So, first, put your camera on the 
tripod, and then take a shot every 10 to 15 seconds. Do this until you have about 10 or 
15 images of the scene. Open those 10 or 15 images in Photoshop, so all of the images 
are open at the same time in different windows (or tabs, if you have this preference 
turned on). Next, go under the File menu, under Scripts, and choose Statistics. From 
the Choose Stack Mode pop-up menu, at the top of the dialog, choose Median. Now, 
click on the Add Open Files button to include all the 10 or 15 images you just opened. 
Click the OK button, and Photoshop analyzes the images looking for movement. As it 
compares all 10 or 15 images, anything that moves gets removed—as long as the tour-
ists are moving through your images, they get removed. If one of your tourists decides to 
sit down, they’ll still be there when the process is done. So, the key is to get everybody 
to move (and yes, I have had to have a friend go and ask someone to move while doing 
this technique. But, all I had to do was get them to move just a couple of feet—that was all  
I needed for it to work, and it did). If it leaves anything behind that you’d like to clean up, 
just grab the Clone Stamp tool (S), Option-click (PC: Alt-click) on a clean area to sample, 
and then just clone over what you want to remove.
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There’s more  
to discover! 

Check out Scott Kelby’s  
How Do I Do That series today!

Visit www.rockynook.com/product-category/scott-kelby-books

http://www.rockynook.com/product-category/scott-kelby-books/

